STORM - Department Center

How To

Hyperlinked
Table of Contents

Department Center
Print Class Roster
Generating Permission Numbers
Managing Advisor on Student’s Record
On-line Grading Process
Course Synopsis
Textbook Entry

Need HELP
Who to Contact with Questions
Technical Information
Click on the [Department Center](#) link from the STORM collection. Use the Department Center to manage all your class and student related activities.

<table>
<thead>
<tr>
<th>STORM</th>
</tr>
</thead>
</table>
| **Student Admin Center (Student)**  
For Department and Central Office Use. View an at-a-glance overview of a student's information. Find quick links to more detailed information and to common administrative tasks. |
| **Department Center**  
For Department and Central Office Use. View and manage classes, view and print course lists, view and print grade rosters, and change options (size, permission numbers) of a class. |
| **Simple Class Search**  
Browse the class schedule by term. Classes offered in any given term are listed in subject order. |
| **Advanced Class Search**  
Use specific criteria to search for a class or classes in a given term. |
| **Browse Course Catalog**  
Browse the Course Catalog. Courses listed here are curriculum committee approved courses which may or may not be scheduled in any given term. |
| **Run Reports**  
Pre-defined reports based on your security. |
| **User Defaults**  
User Defaults allows you set parameters such as term values, programs and plans on various pages were the default value is used (like Class Search). |
Managing Classes

The Department Center will default to the Managing Classes tab. This is where you will see details about the classes you are responsible for.

**Icon Legend** is listed here.

Active icons are located beside each class you manage. They only appear when available.

View Class details including class number, status, grading basis, current enrollment and waitlist numbers and class description.

Class Options allow you to access class characteristics. This link allows you to view and in some cases, depending on your security, make edits to various class characteristics i.e. permission numbers.

You can select other terms by using the drop-down button.
Managing Classes Cont’d.

From the Managing Classes page, click on the subject/number link in the Class column to see class details.

You will be taken to this class details page.

Class Status, class number, units, etc. – general class information found in this section.

Class days & times, room, instructor and dates available here.

Current enrollment and waitlist totals for the class. Cross-listed totals also appear here.

When you are finish reviewing the class details, click here to return to the Department Center page.
Managing Classes Cont’d.

Click on the button to access the class characteristics. This page allows you to view and in some cases, depending on your security, make edits to various class characteristics.

This page is where you will generate permission numbers.

### Class Options

**2010 Fall Term | Regular Academic Session | Duke University | Undergraduate**

**AAAS 122S - 01 (15577)**

<table>
<thead>
<tr>
<th>Class: Human Rights Activism in the Spirit of Paul Murray (Seminar)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Days and Times</td>
</tr>
<tr>
<td>Tu 2:15PM-3:20PM</td>
</tr>
</tbody>
</table>

#### Enrollment Details

<table>
<thead>
<tr>
<th>Enrollment Status</th>
<th>Class Type</th>
<th>Enrollment</th>
<th>Credits</th>
</tr>
</thead>
<tbody>
<tr>
<td>Closed</td>
<td></td>
<td></td>
<td>1</td>
</tr>
</tbody>
</table>

#### Meeting Pattern

<table>
<thead>
<tr>
<th>Meeting Number</th>
<th>Facility ID</th>
<th>Facility Description</th>
<th>Days</th>
<th>Meeting Start Time</th>
<th>Meeting End Time</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>8057001</td>
<td>Bridges House 561</td>
<td>T</td>
<td>2:15PM</td>
<td>3:20PM</td>
</tr>
</tbody>
</table>

#### Instructors

<table>
<thead>
<tr>
<th>Meeting Number</th>
<th>ID</th>
<th>Name</th>
<th>Instructor Role</th>
<th>Print</th>
<th>Grade Roster Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>1637279</td>
<td>Lau, Barbara A</td>
<td>Primary Instructor</td>
<td>Y</td>
<td>Approve</td>
</tr>
</tbody>
</table>

#### Class Capacities

<table>
<thead>
<tr>
<th>Request Room Cap</th>
<th>Enrollment Capacity</th>
<th>Wait List Capacity</th>
</tr>
</thead>
<tbody>
<tr>
<td>5</td>
<td>5</td>
<td>5</td>
</tr>
</tbody>
</table>

#### Permission Numbers

<table>
<thead>
<tr>
<th>Permissons</th>
<th>Used Permissions</th>
<th>Drop Permissions</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>10</td>
<td>0</td>
<td>0</td>
<td>View Permissions</td>
</tr>
<tr>
<td>Drop Permissons</td>
<td>0</td>
<td>Drop Perm Used</td>
<td>0</td>
</tr>
</tbody>
</table>

#### Class Attributes

<table>
<thead>
<tr>
<th>Attribute</th>
<th>Description</th>
<th>Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>BLTH</td>
<td>Bulletin Describing a Course</td>
<td>03-U</td>
</tr>
<tr>
<td>2</td>
<td>BLTH</td>
<td>Bulletin Describing a Course</td>
<td>02-U+G</td>
</tr>
<tr>
<td>3</td>
<td>BLTH</td>
<td>Bulletin Describing a Course</td>
<td>03-G</td>
</tr>
<tr>
<td>4</td>
<td>BLTH</td>
<td>Bulletin Describing a Course</td>
<td>03-U</td>
</tr>
<tr>
<td>5</td>
<td>COMMP</td>
<td>Computation of a Course</td>
<td>C</td>
</tr>
<tr>
<td>6</td>
<td>CURR</td>
<td>Curriculum 2000</td>
<td>CCI</td>
</tr>
<tr>
<td>7</td>
<td>CURR</td>
<td>Curriculum 2000</td>
<td>R</td>
</tr>
<tr>
<td>8</td>
<td>REG</td>
<td>Registration Considerations</td>
<td>C</td>
</tr>
<tr>
<td>9</td>
<td>REG</td>
<td>Registration Considerations</td>
<td>SL</td>
</tr>
<tr>
<td>10</td>
<td>USE</td>
<td>Course Usage Codes</td>
<td>ALP</td>
</tr>
<tr>
<td>11</td>
<td>USE</td>
<td>Course Usage Codes</td>
<td>CZ</td>
</tr>
</tbody>
</table>

### Duke Digital Initiative

- **iPod Requirement**: Not Required
- **Change iPod Requirement**

[Return To Department Center]
Class Roster

From the Department Center tab, to view the class roster, click on the Class Roster icon beside the class.

You will be taken to the Class Roster, the list defaults to a display without pictures.

You can select the status of the roster (i.e. enrolled or waitlisted).

You may print the class roster with or without photos.

- Click on Printer button
- A new html page will open with class roster information
- In your browser, go to File > Print to choose your printer*

From this list, you can send an email to a student or a selected list of students, by checking one or several of the notify checkboxes.

*If you experience problems printing in the Print window, verify that the “Print Frames” option is selected. (Mozilla is on the first tab, Internet Explorer is on the Options Tab).

When emailing students, the system will use the users default email application and BCC the list of students from the instructor’s email address and copy the instructor’s email address.
Grade Roster Report

Grade Rosters are created during the semester by the Registrar’s Office. Once these rosters are generated, the grade roster icon will appear in the Department Center, on the Grade Roster tab or to the left of the Class name.

You will be taken to the Grade Roster, the list defaults to a display without pictures.

Faculty is responsible for grading students. However, your departmental staff can assign you access to on-line grading. They must use the Class Options feature to add you as a Grader to the appropriate class. You will have to be added as an instructor and given the appropriate grade roster access.
Course Synopsis

This is where you can enter additional information about the course to be displayed to students and staff. Course data defaults from data in the system, however synopsis course content is required on this page, and all other fields are optional. You **MUST** publish the synopsis for the information to be viewable by the public.
You have two options for submitting required course materials information for classes you manage:

1) Use STORM via either the **Department Center** (Departmental staff, DUS, DUSA, DGS, DGSA, etc) or **Faculty Center** (Professors, TA, etc). Your course material information will be sent to the Duke Textbook store.

2) Contact the Duke Textbook Store via the online requisition form, email, fax, or in person. Your course material information will be sent to ACES/STORM for public display.
Reports

Based on information from university departments, there are several reports written for public use. Requests for additional reports should be submitted to the University Registrar’s Office.

### Department Report Center

The queries that you have access to are listed below. Click on the Run Query hyperlink next to the query you would like to run. If you can’t find the query you are looking for use the Search Queries button to find your query.

<table>
<thead>
<tr>
<th>Query</th>
<th>Description</th>
<th>Comments</th>
<th>Run to Page</th>
<th>Run to Excel</th>
</tr>
</thead>
<tbody>
<tr>
<td>1 Historical Class Summary</td>
<td>Historical Class Summaries - Sorted by Term, Subject and Catalog Number. Displays the actual historical enrollment over time.</td>
<td>Enter DUEU: SUBJECT, Historical Data</td>
<td>Run to Page</td>
<td>Run to Excel</td>
</tr>
<tr>
<td>2 Book Bagged Classes</td>
<td>Displays closed book bagged by students for a given term (prompt for term). Displays by Subject, Catalog Number, Section, Topic (some topics duplicates).</td>
<td>Enter DUEU: SUBJECT, Term value or select from prompt</td>
<td>Run to Page</td>
<td>Run to Excel</td>
</tr>
<tr>
<td>3 Shows Students &amp; Advisors</td>
<td>Returns all dept students &amp; advisors - student name, id, email, program, plan, subplan, advisor id and advisor name - sorted by advisor last name, then program, plan, subplan if exists.</td>
<td>Enter DUEU as Institution</td>
<td>Run to Page</td>
<td>Run to Excel</td>
</tr>
<tr>
<td>4 Shows Students &amp; Dept Staff</td>
<td>Returns all dept students with Department Staff Assigned - Student name, id, email, program &amp; plan, advisor id and advisor name - sorted by program, plan, subplan (if exists).</td>
<td>Enter DUEU as Institution</td>
<td>Run to Page</td>
<td>Run to Excel</td>
</tr>
<tr>
<td>5 All Students &amp; Dept</td>
<td>Returns all students in a dept - student's unique id, home &amp; mail address, email, program &amp; plan, gender, ethnicity - sorted by program, plan, subplan (if any), last name.</td>
<td>Enter DUEU as Institution</td>
<td>Run to Page</td>
<td>Run to Excel</td>
</tr>
<tr>
<td>6 Students by Academic Plan</td>
<td>Students by academic plan - student's unique id, home &amp; mail address, email, program &amp; plan, gender. Select the plan using the modifying option.</td>
<td>Enter DUEU as Institutions</td>
<td>Run to Page</td>
<td>Run to Excel</td>
</tr>
</tbody>
</table>
Advisors

On the Advisor tab, you have the ability to add/change/delete advisor(s) on student records you have access to.
Print Class Roster

You are given the option to print your class roster either with or without photos. The class roster defaults to the list without photos.

NOTE: Users with Firefox version 2.0.0.16 can not accurately print class rosters with pictures. This is the case in both Mac and PC versions. Please take a look at the SISS Website for technical requirements.

The Class Roster page defaults to the enrolled class list. You will need to select the Enrollment Status for waitlisted students or all students (both enrolled and waitlisted).

Without Photos:
- Click on the “Printer Friendly Version” button at the bottom of the page (this will generate a .PDF)
- A new page will open with class roster information

Please read the Family Educational Rights & Privacy Act (FERPA) Statement for information about the release of student data.

Use the “Printer Friendly Version” button to print the class roster in .PDF format.
Print Class Roster cont’d

With Photos:

Select the “Include Photos in List” button to display class roster with photos.

- Click on “Printer Friendly Version” button at the bottom of the page (this will generate a .PDF)
- A new page will open with class roster information including photos

NOTE: Pop-Up Blockers: Be sure to add this STORM URL to your pop-up blocker exceptions within your browser. In some cases, additional pages will not open if you are blocking pop-ups and have not granted this page as an exception.
Who do I contact if I have problems or questions?

For technical questions:

OIT Help Desk
Phone: (919) 684-2200
Fax: (919) 684-4400
Email: help@oit.duke.edu
Website: http://www.oit.duke.edu/help/

For class roster questions:

Office of the University Registrar
Phone: (919) 684-2813
Fax: (919) 684.4500
Email: registrar@duke.edu
Website: http://registrar.duke.edu/

Medical School Registrar's Office
Phone: (919) 684-2304
Fax: (919) 684-2593
Email: medreg@mc.duke.edu
Website: http://medschool.duke.edu/modules/som_registrar/index.php?id=1
Generating Permission Numbers

Placing consent on a class (either instructor or department) requires that the student have permission to enroll in the class online. Other conditions also require permission before the student can enroll.

There are several conditions that may require permission numbers. Class Permission Numbers are used by students to enroll in classes that are full (class enrollment limit); require consent; or requisites (co-requisites and pre-requisites). Depending on the type of restriction in place, Permission Numbers are obtained from the class instructor or the department academic administrator. Permission Numbers can be entered by students when enrolling online through ACES. Class permission numbers are usually valid only during the ADD/DROP period and will expire after the last day to add/drop classes.

In the Department Center, a list of classes you manage will be displayed. Select the Class Options icon next to the class you want to add permission numbers.

<table>
<thead>
<tr>
<th>Class</th>
<th>Class Title</th>
<th>Days &amp; Times</th>
<th>Instructor Full</th>
<th>Room</th>
<th>ENR/ CAP</th>
<th>WAIT</th>
<th>Class Roster</th>
<th>Cross Listed Class Roster</th>
<th>Cross Section</th>
<th>Grade Roster</th>
<th>Class Options</th>
</tr>
</thead>
<tbody>
<tr>
<td>ENGLISH 268-03 (5067)</td>
<td>STUDIES/LITERARY TOPICS (Seminar) SHAME</td>
<td>WF 4:25PM - 5:40PM</td>
<td>Dorothyz Mozee, Charlotte Sussman</td>
<td>Social Sciences 105</td>
<td>8/15</td>
<td>0</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>ENGLISH 4983-03 (5074)</td>
<td>1ST-YR SEM LIT (TOP) (Seminar) GREAT AMERICAN NOVELS</td>
<td>MW 11:40AM - 12:55PM</td>
<td>Buford Jones</td>
<td>Allen 317</td>
<td>14/15</td>
<td>0</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>ENGLISH 629-01 (5076)</td>
<td>INTRO CREATIVE WRITING (Seminar)</td>
<td>M 10:05AM - 12:35PM</td>
<td>Faulkner Fox</td>
<td>Social Sciences 105</td>
<td>14/15</td>
<td>0</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>ENGLISH 636-02 (5077)</td>
<td>INTRO CREATIVE WRITING (Seminar)</td>
<td>M 1:15PM - 3:45PM</td>
<td>Faulkner Fox</td>
<td>Allen 304I</td>
<td>15/15</td>
<td>0</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

On the Class Options page, go to the Permission Number section.
Generating Permission Numbers Cont’d.

In most cases, at least 10 permission numbers will be generated for you to use. So, you can view the permission numbers by selecting the View Permissions link.

This is a list of the permission numbers you can distribute to students.

<table>
<thead>
<tr>
<th>Permission</th>
<th>Used</th>
<th>Used By</th>
<th>Name</th>
<th>Used Date</th>
<th>Expire Date</th>
<th>Closed Class</th>
<th>Req Not Met</th>
<th>Consent Req</th>
</tr>
</thead>
<tbody>
<tr>
<td>666333</td>
<td>N</td>
<td></td>
<td></td>
<td>09/04/2009</td>
<td></td>
<td>Y</td>
<td>Y</td>
<td>Y</td>
</tr>
<tr>
<td>959740</td>
<td>N</td>
<td></td>
<td></td>
<td>09/04/2009</td>
<td></td>
<td>Y</td>
<td>Y</td>
<td>Y</td>
</tr>
<tr>
<td>950066</td>
<td>N</td>
<td></td>
<td></td>
<td>09/04/2009</td>
<td></td>
<td>Y</td>
<td>Y</td>
<td>Y</td>
</tr>
<tr>
<td>219888</td>
<td>N</td>
<td></td>
<td></td>
<td>09/04/2009</td>
<td></td>
<td>Y</td>
<td>Y</td>
<td>Y</td>
</tr>
<tr>
<td>617251</td>
<td>N</td>
<td></td>
<td></td>
<td>09/04/2009</td>
<td></td>
<td>Y</td>
<td>Y</td>
<td>Y</td>
</tr>
<tr>
<td>309246</td>
<td>N</td>
<td></td>
<td></td>
<td>09/04/2009</td>
<td></td>
<td>Y</td>
<td>Y</td>
<td>Y</td>
</tr>
<tr>
<td>924300</td>
<td>N</td>
<td></td>
<td></td>
<td>09/04/2009</td>
<td></td>
<td>Y</td>
<td>Y</td>
<td>Y</td>
</tr>
<tr>
<td>679919</td>
<td>N</td>
<td></td>
<td></td>
<td>09/04/2009</td>
<td></td>
<td>Y</td>
<td>Y</td>
<td>Y</td>
</tr>
<tr>
<td>982905</td>
<td>N</td>
<td></td>
<td></td>
<td>09/04/2009</td>
<td></td>
<td>Y</td>
<td>Y</td>
<td>Y</td>
</tr>
<tr>
<td>113841</td>
<td>N</td>
<td></td>
<td></td>
<td>09/04/2009</td>
<td></td>
<td>Y</td>
<td>Y</td>
<td>Y</td>
</tr>
</tbody>
</table>

Permission – the permission number  
Used – N = not used, U = used, D = used, then dropped  
Used By – student’s ID number that used the number  
Name – student’s name  
Used Date – date the student used the permission number to enroll in the course  
Expire Date – date the permission number will no longer be valid  
Closed Class – Y = Yes, overrides a full class  
Req Not Met – Y = Yes, overrides any hard pre-reqs for the class  
Consent Req – Y = Yes, overrides instructor consent

NOTE: You can download the list of permission numbers into an Excel file to keep track of whom you assigned each number by selecting the button. Make sure your browser pop-up blocker is NOT on. When students use their permission number, you will see it here.
Generating Permission Numbers Cont’d.

If you need to generate additional permission numbers, click the Add Permissions link. Enter the number of permission numbers you would like to create and what attributes you would like them to have, the default is to allow for pre-req overrides, consent overrides, and closed class overrides.

Add Permissions

Enter the number of permissions you would like to create and what attributes you would like them to have and press the Save Attributes button. If you do not wish to create attributes at this time press the Return to Class Options button.

<table>
<thead>
<tr>
<th>Permissions to Add</th>
</tr>
</thead>
<tbody>
<tr>
<td>Number of Permissions</td>
</tr>
<tr>
<td>Requisites Not Met</td>
</tr>
<tr>
<td>Closed Class</td>
</tr>
</tbody>
</table>

Save Permissions | Return to Class Options

**Requisites Not Met** – Will give permission to override the course requirements for the student to meet

**Consent Required** - Will give permission to enroll in a course that requires Instructor or Department Consent

**Closed Class** - Will give permission to allow a student into a class that is closed

If you uncheck any of these boxes, the permission number will not override that particular criteria. If you want the permissions to act as they did in the previous version of STORM, leave the boxes checked.

The expiration date is usually the last day of add/drop.

Click the Save Permissions to generate the permission numbers.
Who do I contact if I have problems or questions?

For technical questions:

OIT Help Desk
Phone: (919) 684-2200
Fax: (919) 684-4400
Email: help@oit.duke.edu
Website: http://www.oit.duke.edu/help/

For course and registration questions:

Office of the University Registrar
Phone: (919) 684-2813
Fax: (919) 684.4500
Email: registrar@duke.edu
Website: http://registrar.duke.edu/

Medical School Registrar’s Office
Phone: (919) 684-2304
Fax: (919) 684-2593
Email: medreg@mc.duke.edu
Website: http://medschool.duke.edu/modules/som_registrar/index.php?id=1
MANAGING ADVISORS ON STUDENT RECORDS

1. Search by Plan/Major

From the Department Center under the Advisors tab – Search for the plan/major in which you wish to update advisors. The Career, Program and Plan values will use your operator defaults (if set) to populate the fields. Otherwise, you would need to fill in the values.

Once all of the appropriate values are entered, select the search button.
2. Review Students In The Plan

The page will return all students in that plan and their current advisor. Note, it will return both first and second major advisors, however only the plan entered in the search can be changed/removed/added to.

Section 1:
Student List – displays a list of the students in the selected plan with an advisor. To view addition information about the student, select the hyperlink of the student’s name.

Section 2:
“list view” button – provides a downloadable list of the students. Note, students with multiple plans with be listed multiple times.

Section 3:
Advisor List – displays all advisors currently assigned to these students.

Section 4:
Advisor Actions (filter by selected Advisor or add/replace advisor). You have the option to add additional advisors to this list.
Managing the Advisors:

A) Replace an existing Advisor

Select the replace checkbox on the student list next to the advisor you want to replace. You can choose one student, multiple students or select the “Replace All” check box. Select the Advisor you wish to replace with or add to the student. Select the Add/Replace Advisor(s) button.

1. Select the advisor you want to replace.
2. Select the advisor you want to add.
3. Select the “add/replace advisor(s)” button.

Once the Add/replace button is selected, the change appears in pink. The change will not be official until the “save pending changes” button is selected.
B) Add a new Advisor

If a student does not have an advisor for the plan selected, this is uncommon for undergrads, but fairly common with Grad/Prof students.

Follow the steps for replacing an advisor except use the “Add” checkbox (located to the left of the student’s information) rather than the “Replace” checkbox. However, when adding a new advisor, the advisor type must be chosen from the list. The current advisor types are:

As with replacing an advisor, a potential change is noted in pink and must be saved before it is a permanent change.
C) Viewing Advisor lists

The advisor list shows all advisors currently assigned to the selected plan. It also gives a count of the number of advisees assigned to each advisor (by career chosen). Select any advisor name hyperlink and a page that lists all students assigned to the advisor will appear. This list can be downloaded to excel.
On-line Grading Process for Departmental Staff

You MUST be assigned as a grader for the class(es) you need to enter grades before you start this process.

1) On the new STORM Main Menu page, click the Faculty Center link.

2) Select the Grade Roster icon next to the class for which you want to enter grades.
3) You will enter grades on the Grade Roster page. After entering grades you will then SUBMIT the entered grades. You have several approval status (submission) options:

a) **Not Submitted** – displays a list of students with grades that have not yet been saved, submitted or posted (recorded on the student’s record). This list’s grade input is editable prior to submitting. The grade roster will default to this list.

b) **Submit Partial List** – submits a partial list of students with grades that you want posted, while leaving a remaining list of un-graded students. You have the ability to enter grades and submit the remaining grades at a later time, using the **ENTER / EDIT NON-POSTED GRADES** button. You would use this feature, for example, when entering grades for graduating seniors, prior to entering grades for other students.

c) **Submit All Grades** – submits the entire list of students with grades that you want posted and select the **SUBMIT GRADES** button to submit grades to be posted.

d) **Upload Grades** – uploads grades from an external file (*.csv file type only). Use the **Click here to upload grades from a *.csv file** link.

---

Grades are officially POSTED when they appear in the Official Grade column. These grades CANNOT be changed via this on-line process.

---

Save will create a “work” file for you to continue to update your grades. Save DOES NOT submit grades for posting, you MUST click one of the SUBMIT GRADES buttons, either “All Grades” OR “Partial List” to have grades submitted for posting by the Office of the University Registrar or the Medical School Registrar’s Office.
NOTE: Submitting grades is the equivalent to signing an official Grade Sheet and sending it to the Office of the University of Registrar OR the Medical School Registrar’s Office. Once a grade has been submitted and appears as a posted grade, you CANNOT change that grade on-line. For a grade change, the instructor needs to send a letter on departmental letterhead to the Office of the University Registrar explaining the need for a grade change. Per faculty policy, grade changes are only allowed as a result of miscalculations or transcription errors OR simply contact the Medical School Registrar’s Office.

YOU'RE DONE!
Upload Grades

1) On the Grade Roster page in STORM, click the Click here to upload grades from a *.csv file link to open a file of your current roster.

NOTE: If you use your own spreadsheet for the grade roster, the columns and fields MUST be in exactly the same order and format as the downloaded version. You may simply cut and paste columns into the downloaded version. Check your spreadsheet VERY CAREFULLY to make sure all grades are entered correctly for each corresponding student and that the students are listed in the same order as those on the downloaded sheet.

2) Browse for your grade roster file and click the Upload button.
Blackboard Users:

**In BlackBoard**

1. Go to Control Panel->Assessment->Gradebook and use Add Item to create a Midterm or Final Grades category that is a letter grade and populate as needed.

2. Go to the Control Panel->Course Tools->Export Official Grades; pick the appropriate grades type, then pick the grade category and download.

The .csv file generated from the Blackboard process can be imported directly into the Grade Roster on STORM. The grades on the Grade Roster can be altered before re-saving as a .csv file.

FYI, the key to the grade roster is the student’s id, not their name, so alphabetization should not matter.

3) The grades are uploaded into the Grade Roster. Select Submit Grades for grades to be posted.

**YOU'RE DONE Uploading!**
FAQs

Who does what?

A person with Grade access (i.e. department assistants or TA) can only input grades and save; while a person with Approve access (usually the primary/secondary instructor) can input and submit grades to be posted. The Office of the University Registrar or the Medical School Registrar’s Office will officially “post” (record on the students’ record) all submitted grades.

What if I do not see the Faculty Center link on the STORM page?

Grade rosters are created near the end of the semester, or the mid-term in the case of mid-term grading. When grade rosters are created, a message is sent to the departmental staff. Check with them to see if rosters have been created. If they have been created and you still do not see the “Faculty Center” link, you may not have been given access as an on-line grader. Contact your departmental staff to give you the appropriate on-line grading access. If the rosters have been created and you have the appropriate access, contact the OIT HelpDesk at 684-2200 for assistance.

How do I become a grader or designate someone else as a grader (i.e. TA)?

Your departmental staff can assign access to on-line grading. They must use the Class Options feature to add a Grader to the appropriate class. You will have to add them as an instructor and give them the appropriate grade roster access.

Who do I contact to change a posted grade?

The grade change policy has not changed. Faculty policy requires that, “changes in grades may be made only because of an error in calculation or an error in transcription. Changes in grades may not be based on the late submission of required work, the resubmission of work previously judged unsatisfactory, or on additional work.” If the proposed grade change meets these criteria, or if you are changing a grade of I or X to a regular grade within the allotted deadlines, a grade change request signed by the instructor of record should be submitted on departmental letterhead to Bruce Cunningham, University Registrar, Box 90054, fax (919) 684-4500. Contact the Medical School Registrar’s Office with any medical student grade changes.

Who do I contact if I have problems uploading grades?

See the Upload Grade section of this document for detailed upload instructions. You must be VERY CAREFUL to review the .csv file you are uploading, especially if you are using your own spreadsheet.
Who do I contact if I have problems or questions?

For technical questions:
OIT Help Desk
Phone: (919) 684-2200
Fax: (919) 684-4400
Email: help@oit.duke.edu
Website: http://www.oit.duke.edu/help/

For course and registration questions:
Office of the University Registrar
Phone: (919) 684-2813
Fax: (919) 684-4500
Email: registrar@duke.edu
Website: http://registrar.duke.edu/

Medical School Registrar's Office
Phone: (919) 684-2304
Fax: (919) 684-2593
Email: medreg@mc.duke.edu
Website: http://medschool.duke.edu/modules/som_registrar/index.php?id=1
To enter a course synopsis, first go to your “Department Center” or “Faculty Center” view of classes and find the class to which you want to add a synopsis (entering the correct Term, Subject, and Full Class List if necessary).

Whether the link to your class reads “Add,” “Edit,” or “View,” you will be taken to the same basic page where you will be able to:

1. publish a new course synopsis (“Add”),
2. edit a synopsis that’s been partially entered and saved, but not yet published (“Edit”), or
3. view a published course synopsis, and, if you are the synopsis author or designated representative, make changes or corrections to that published course synopsis (“View”).

**NOTE:** You must click on the green “publish” button in order to have your course synopsis be viewed by the public.
I. ADDING A NEW COURSE SYNOPSIS

When you click on the “Add” or “Edit” links, you will see the following page:

Notice the buttons on the right side of this page:

- **save** - information will be saved for future edits (NOT, yet viewable to the public).
- **copy from** - copy course information from a previous course.
- **preview** - view the course information displayed to the public.
- **publish** - post information to be displayed to the public.
- **help** - help documentation for course synopsis.
- **department center** - returns you to the Department Center (if you are in the Faculty Center the button will read “faculty center”).
Course Synopsis Cont'd.

COPY FROM
If you wish to use a synopsis that has been published in a previous term:

- click on the “copy from” button on the right of the screen,
- from the resulting screen, use the drop-down menu to find the term of the published synopsis, and click on the green “search” button,
- click on the green “copy” button, and that synopsis will automatically populate in the current synopsis you’re entering. (If you’d like to review the past synopsis before clicking the copy button, click on the blue link of the course title and the synopsis will open in a separate window).

PREVIEW
To view what will be displayed to the public:

- click on the “preview” button on the right of the screen.
- a new window will open to the display.
Course Synopsis Cont’d.

**NOTE:** THIS IS OPTIONAL - Use html code for formatting your text (i.e. BOLD, ITALICS, URLS, etc.)
Here are some basic HTML codes you can use:

<table>
<thead>
<tr>
<th>Tag</th>
<th>Name</th>
<th>Code Example</th>
<th>Browser View</th>
</tr>
</thead>
<tbody>
<tr>
<td>&lt;a</td>
<td>anchor</td>
<td><code>&lt;a href=&quot;http://www.sissoffice.duke.edu/&quot;&gt;Visit Our Site&lt;/a&gt;</code></td>
<td>Visit Our Site</td>
</tr>
<tr>
<td>&lt;b</td>
<td>bold</td>
<td><code>&lt;b&gt;Example&lt;/b&gt;</code></td>
<td>Example</td>
</tr>
<tr>
<td>&lt;big</td>
<td>big (text)</td>
<td><code>&lt;big&gt;Example&lt;/big&gt;</code></td>
<td>Example</td>
</tr>
<tr>
<td>&lt;center&gt;</td>
<td>center</td>
<td><code>&lt;center&gt; This will center your text &lt;/center&gt;</code></td>
<td>This will center your text</td>
</tr>
<tr>
<td>&lt;i</td>
<td>italic</td>
<td><code>&lt;i&gt;Example&lt;/i&gt;</code></td>
<td>Example</td>
</tr>
<tr>
<td>&lt;IMG SRC</td>
<td>image</td>
<td><code>&lt;IMG SRC=&quot;http://www.sissoffice.duke.edu/smiley.gif&quot;&gt;</code></td>
<td>😊 (use .jpg, .gif or .png)</td>
</tr>
<tr>
<td>&lt;p</td>
<td>paragraph</td>
<td><code>&lt;p&gt;Example&lt;/p&gt;</code></td>
<td>Example</td>
</tr>
<tr>
<td>&lt;u</td>
<td>underline</td>
<td><code>&lt;u&gt;Example&lt;/u&gt;</code></td>
<td>Example</td>
</tr>
</tbody>
</table>

For addition html codes see

**PUBLISH**

You can make any changes you wish to this page, and when you’ve entered the information you desire:
- click on the green “publish” button
- your synopsis will be ready for public viewing, or you can click on the green “save” button, and the information you have entered will be saved, and you can return to it later (please note that clicking on the “save” button will not allow your synopsis to be viewed by the public).

**NOTE:** When the course synopsis is published, it will have a date stamp on it in the green “Published” bar.
Course Synopsis Cont’d.

Once you “publish” your synopsis, you have the option to publish to combined/related course sections by clicking on the green “publish related” button. A page with the combined/related sections list will appear. Check the “Replace” checkbox for the courses for which you want to copy the current course synopsis information. Then, click the “publish”. The status will update to “Published” on this page.
II. EDITING A PUBLISHED COURSE SYNOPSIS

You can make any changes you wish to already-entered course synopses by clicking on the “unpublish” button and making your revisions. Then, after you have made your edits, either
• click on the green “publish” button, whereupon your synopsis will be ready for public viewing,
• or click on the green “save” button, and the information you have entered will be saved, and you can return to it later (please remember that clicking on the “save” button will not allow your synopsis to be viewed by the public).

III. EDITING A SAVED, UNPUBLISHED COURSE SYNOPSIS

If you have entered partial information for a course synopsis, click the links under course synopsis and make any revisions you desire. After you have made your edits, either
• click on the green “publish” button, for public viewing,
• or click on the green “save” button, and the information you have entered will be saved, and you can return to it later (please remember that clicking on the “save” button will not allow your synopsis to be viewed by the public).
Who do I contact if I have problems or questions?

For technical questions:

OIT Help Desk
Phone: (919) 684-2200
Fax: (919) 684-4400
Email: help@oit.duke.edu
Website: http://www.oit.duke.edu/help/

For course synopsis questions:

Contact the appropriate departmental administrator.
Course Book Information

Effective Fall 2010 the Higher Education Opportunity Act of 2008 (HEOA) requires all institutions receiving federal financial aid to “publish,” in time for registration, a list of all required and recommended books and other course materials for all classes offered at the institution. This includes undergraduate, graduate, and professional schools. The items we must make public are:

1. Book title, including edition
2. Book author
4. Book retail price

For further information about the law and Duke’s efforts to comply with it, go the following website http://www.registrar.duke.edu/registrar/facultypages/textbooks.html

***********************

You have two options for submitting your course materials information:

1) Use STORM via either the Department Center (Departmental staff, DUS, DUSA, DGS, DGSA, etc) or Faculty Center (Professors, TA, etc). Your course material information will be sent to the Duke Textbook store.

2) Contact the Duke Textbook Store via the online requisition form, email, fax, or in person. Your course material information will be sent to ACES/STORM for public display.

NOTE: The Duke Textbook Store is the system of record for textbook/course material information; they will display the “final” list of course materials. **STORM is simply a way to enter your course materials information.**
Course Book Information Cont’d.

Whether the link to your class reads “Create Booklist” or “Maintain Booklist,” you will be taken to the same Booklist page where you will be able to enter course material information for the course and submit it to the Duke Textbook Store.

The primary instructor’s contact information will default here in the General Information section, please update this information if another person should be contacted with questions.
Course Book Information Cont'd.

Booklist Options

You MUST select one of the four booklist options:

1. **List Books Entered Below (default)** – enter the list of course materials needed for the course.

<table>
<thead>
<tr>
<th>Author’s Name (Full)</th>
<th>Title</th>
<th>Edition</th>
<th>ISBN Number</th>
<th>Publisher</th>
<th>(Check if Optional)</th>
<th>Desk Copy?</th>
<th>Status</th>
</tr>
</thead>
<tbody>
<tr>
<td>Jeffery C. Stewart</td>
<td>1001 Things Everyone Should Know About</td>
<td></td>
<td>006546576X</td>
<td>MAIN STREET BOOK</td>
<td></td>
<td></td>
<td>Ready</td>
</tr>
</tbody>
</table>

**NOTE:** Make sure you **Save** your Booklist in order to **Submit** it to the bookstore. If you DO NOT Submit your course booklist, it will not be viewable in the Duke Textbook Store listing. Please allow 3-5 business days for the submitted items to be displayed on the Duke Textbook Store’s website. A link will appear in the Textbook Store Course Status section when the course materials are listed on the Duke Textbook Store’s website.

Enter any additional information about your booklist in the “Additional comments for Duke Textbook Store” section.
MULTIPLE COURSE SECTION ENTRY: If you have the same course material(s)/textbook(s) you would like listed on Duke Textbook Store’s website for multiple sections, enter the booklist information on one course and enter the list of courses sections in the “Additional comments for Duke Textbook Store” field. The Duke Textbook Store will list the course material(s)/textbook(s) on each section.

1. **Use Last Term’s Booklist** – request that the bookstore use the booklist from the last term.

   This feature is only available to you if you submitted a course materials requisition to the bookstore previously (If there is no previous booklist on file at the bookstore, you will get an “invalid value” error message when you select this option).

2. **No Texts Required** – no course materials are needed for the course.

   Select this option if the course does not have **ANY** course materials that must be purchased.

3. **To Be Determined** – a list of course materials has not yet been finalized for the course.

   Select this option if the required or recommended course materials have not been determined yet for the course.

**Other Bookstores:**

- **Medical School (including Nursing and Allied Health programs)** – uses the Medical Center Bookstore, see [http://www.dukestores.duke.edu/medicalcenterstore/books/](http://www.dukestores.duke.edu/medicalcenterstore/books/)

- **Divinity School** - uses the Cokesbury Bookstore, see [www.divinity.duke.edu/academics/courses](http://www.divinity.duke.edu/academics/courses) for course materials and textbooks.
Who do I contact if I have problems or questions?

For technical questions:

OIT Help Desk  
Phone: (919) 684-2200  
Fax: (919) 684-4400  
Email: help@oit.duke.edu  
Website: http://www.oit.duke.edu/help/

For textbook/course materials questions:

Contact the appropriate textbook store:

**Duke University** – uses the Duke Textbook Store, see http://www.dukestores.duke.edu/textbook.php

**Office of the University Registrar**  
Phone: (919) 684-2813  
Fax: (919) 684.4500  
Email: registrar@duke.edu  
Website: http://registrar.duke.edu/

**Medical School (including Nursing and Allied Health programs)** – uses the Medical Center Bookstore, see http://www.dukestores.duke.edu/medicalcenterstore/books/

**Medical School Registrar's Office**  
Phone: (919) 684-2304  
Fax: (919) 684-2593  
Email: medreg@mc.duke.edu  
Website: http://medschool.duke.edu/modules/som_registrar/index.php?id=1

**Divinity School** - uses the Cokesbury Bookstore, see www.divinity.duke.edu/academics/courses for course materials and textbooks.